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Modul 6

Wireshark Menu

The Wireshark file menu contains the fields shown:

File:

M odd-hitppeap - o »
File | Edit V Go Capture Analyze Statistics Telephony s Tools Help
Open -0
Open Recent » Y - Bpression.. | +
L L
Merge... fraton Protocol  Length Info 5
Import from Hex Dump... TCP 1454 [TCP segment of a reassembled POU]
Close -
segment of a reassembled POU]
ave . CP Window Update] [TCP ACKed unseen s.4 [ACK]
Save As. Ctri=Shift=5
File Set » segment of a reassembled PDU]
Export Specified Packets.. segment of a reassesbled
Export Packet Dissections »
; . segment of a reassembled
Export PDUs to File. segrent of
Export SSL Session Keys...
Export Objects * lts), 1454 bytes captured (11632 bits)
i :50:56:¢0:00:01), Dst: Vimware_42:12:13 (90:0c:29:42:12:13)
Print... Curlep .121.1.131, Dst: 172.16.8.122
rt: 10554 4), Dst Port: , Seq: 1, Ack: 1, Len: 1
Quit CieQ p 1@554 (10554), Dst Port: 80 (80), Seq C L 400
20 Bc 29 42 12 13 90 50 56 c@ 00 01 86 00 45 00 A
5 a0 01 41 00 9@ 6a 86 d3 90 B 1 1
©0 7a 29 38 00 5@ a7 Sc 04 48 e2 e2 ee bf 50 10
£f £f 77 67 00 00 38 54 73 57 77 51 74 45 79 4e
45 61 33 78 70 74 44 63 51 4f 2f 6b 75 31 41 52
52 66 47 59 67 53 32 41 34 47 59 35 31 v
@7 Packets: 3083 - Displayed: 3083 (100. Load time: 0:0,100 || Profile: Default
Ml cdd-ntt - o X
File | Edit Go Capture Analyze Statistics Telephony Wireless Tools Help
a1 Copy » f; = qQaqo
!Iﬂl, R  Find Packet... CtrieF [ =3 +| Bxpresson.. | +
Find Next Ctri=N Protocol  Length Info
Find Previous Ctri=B TP 1454 [1CP segment of a reassembled POU]
Mark/Uneark Packet Ctr=M segment of a reassembled POU)
Window Update] [TCP ACKed unseen 5.4 [ACK] Seq=1 Ack=11201 Win=63000 Len=9

Mark All Displayed Ctrl=ShiftsM

segment o

segment of

segment of

Fr bytes captured (11632 bits)
B 0:00:01), Dst: Vamare_42:12:13 (8@:8c:
Ie 31, Dst: 172.16.0.122
T (18554), Dst Port: 88 (88), Seq: 1,
Time Shift... Ctrl-Shift-T
Packet Comment...
Configuration Profiles... Ctrl-Shift-A
Preferences... CtrleShift«P
29 42 12 13 00 50 56 c@ 00 01 08 00 45 00 )B...P
01 41 00 00 62 06 d3 90 c& 79 01 83 ac 10 A
29 3a 00 5@ a7 Sc 04 48 €2 2 ee bf 50 10 A
77 67 90 0@ 3@ 54 73 57 77 51 74 45 79 4e g..0T sinQtEy
33 78 76 74 44 63 51 4f 2f 6b 75 Ea3xptDc QO/kulAR
47 59 67 53 3 34 47 59 35 31 RFGYES2A 4GYS1V32

reassenbled POU]
reassenbled POU)

reassembled PDU

reassesbled Pl

29:42:12:13)

Ack: 1, Len: 1400

Profile: Defauit

Packets: 3083 * Displayed: 3083 (100.0%)




View:

M rip-ocopeap - o X
file Edit | View Go Capture Anslyze Statistics Telephony Wireless Tools Help
4 m 7 [¥ MainToolbar |aaa
(W [iccly =0 ¥ Fiter Toolbar [ B )+
M. ¥ StatusBar Destnation Protocol  Length  Shiftcount Fiags Info -
T 1 10.0.0.2 TP 7% oxele 32323 »
f 1
2 I L2 TP 42 32323 » B
¥ Packet List
¥ Packet Details
Packet Byte
] 7 &  Packet Diagram PUT /1 HTT)
8 32323 + B
Time Display Format »
Name Resolution »
11 PUT /3 HTT
12 o » 32323 + 80
14 Expand Subtrees 32323 -+ 88
<
Expand Al
Frame 1 CaH!pse Al Led (624 Internet Protocol Version 4 "~
dsbarae — ot Py e b S v b @
Transmi ort: 84
Colorize Packet List P Version | Hesdert | Diffeentited Sevices F. Total Length
Coloring Rules...
ol P 5 Identification Flags Fragment Offset
TeRTaon P Time to Live | Frotocol Header Checksum
TF  Resize Columns Ctrl+Shift+R Source Address
Internals % Destination Address
Show Packet in New Window
Reload as File Format/Capture  Ctrl+Shift-F | Eemeision Coater) Biotoc
B Relosd CuieR WA R I NN S N U L o B B A B BB B A AN A
’ Source Port Destination Port
Sequence Number
Acknowledgment Number
< > 2 % v
7 http-ooo.pcap Packets: 16 * Displayed: 16 (100.0%) Profile: decode_as_prefs
M odd-http.pcap - o X
File Edit View | Go | Capture Analyze Statistics Telephony Wireless Tools Help
F| [} Go to Packet.., Ctrl«G | [CRCC i
[ o to Linked Packet L 3 - Bxpression..  +

Ctrl+Dow
Cri-Up

No. = Next Packet
Previous Packet
02573 W First Packet

02574 &  Last Packet Ctrl+End

Auto Scroll in Live Capture

Ctrl=Home

182939200 T2 T 13T T7ZI6T
172.16.0.122

172.16.8.122

00 Oc 29 42 12 13 @0

w

56 c0 00 01 08 20
5a d3 9@ ¢8 79 81 33

2@ 7a 29 3a ee S0 a7
ff #f 77 67 00 00 30 73 57 77 51 74 45
(] 51 4f 2f 6b 75 31
47 59 35 31 56

@
CEAGS

B oo

59 67 53 32

,
w
4

otocol  Length Info

P 1454 [TCP segment of a reassembled PDU]
454 [TCP segment of a reassembled PDU]
54 [TCP Window Update] [TCP ACKed unseen
segment of a reassembled PDU]
segment of a reassembled PDU]

segment of

Frame 1: 1454 bytes on wire (11632 bits), 1454 bytes captured (11632 bits)

Ethernet IT, Src: Vmware c0:00:01 (80:50:56:c0:00:01), Dst: Vmware 42:12:13 (80:@8c:29:42:12:13)
Internet Protocol Version 4, Src: 200.121.1.131, Dst:
Transmission Control Protocol, Src Port: 10554 (1@554), Dst Port:

172.16.0.122
8e (8@), Seq: 1, Ack: 1, Len: 1400

RFGYES2A 46YS1V32

Packets: 3083 * Displayed: 3083 (100.0

4 [ACK] Seg=

Profile: Defauit

Load time: 0:0. 100

48



Capture:

M cdd-titp.peap _ o X
File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
dnm ® @ Options... Ctri=K =qqeo

A Start Ctr-E
W Stop 3

Protocol  Length
TCP 1454 segment of a reassembled POU]

Capture Fifters...
30.05738 26 [TCP segment of a reassembled POU)
4.0.025749 17 sselbnialisinideen [TCP Window Update] [TCP ACKed unseen s.4 [ACK] Seq=1 Ack=11201 Win=63000 Len=@

.182939 .121.1. .16.0. [TCP segment reassesbled PDU]
reassembled POU
154162 g .16.0. [TCP segment reassembled PDU)

.179906 .121.1 .16.9. 1 segment of a reassembled POU)

Frame 1: 1454 bytes on wire (11632 bits), 1454 bytes captured (11632 bits)

Ethernet II, Src: Vmware c0:00:01 (00:50:56:c@:00:01), Dst: Vmware 42:12:13 (00:0c:20:42:12:13)
Internet Protocol Version 4, Src: 200.121.1.131, Dst: 172.16.0.122

Transmission Control Protocol, Src Port: 18554 (18554), Dst Port: 5@ (88), Seq: 1, Ack: 1, Len: 1288

20 @c 29 42 12 13 @0 50 56 <@ 0@ 01 23 20 45 00
@5 a2 91 41 00 02 62 06 d3 9@ c8 79 @1 83 ac 1
@@ 7a 29 3a @ 5@ a7 S5c 94 48 e2 e2 ee bf Se 18
ff £f 77 67 @2 @@ 30 54 73 57 77 51 74 45 79 4e . Wg..0T si

45 61 33 78 7@ 74 44 63 51 4f 2f 6b 75 31 41 52  Ea3xptDc QO/kulAR
S2 66 47 59 67 53 32 41 34 47 59 35 31 56 33 32  RfGYES2A 4GY51v32 -
| @7 Packets: 3083 - Displayed: 3083 (100.0%) * Load tme: 0:0.100 || Profil: Defauit
Analyze:
M hitp-ooo.pcap = a X
File Edit View Go Capture  Analyze Statistics Telephony Wireless Tools Help
FL ® RE Display Filters... LiJ
] \'—,,‘ & chlir Qi b Display Filter Macros...
No. .Tm Seurce Display Filter Expression... Protocol .Lengvh.lnfo
T 1 ©.000000 10.8. I‘CP 78 32323 =+ 80 [ACK] Seq=1 Ack=1 Win=8192 Len=:
1 A Cols Ctrl+Shift+1 =
2 0.000001 10.0. ety s Loy it AN 42 32323 » 80 [ACK] Seq=39 Ack=1 Win=8192 Len
Apply as Filter »
Prepare as Filter >
Conversation Filter 3
7 ©.000006 1e.@. Enabled Protocols... Ctrl+Shift+E 41 Continuation
B8 ©.000807 16.0. cP 78 32323 80 [ACK] Seq=62 Ack=1 Win=8192 L
Decode As... CtrlShifts U =D ALL G SeqatioiAc . = v
< Reload Lua Plugins Ctrls Shifts L 2
Frame 1: 78 bytes on wire ts) ~
Internet Protocol Version scTe *
v Transmission Control Prot Follow » jeq: 1, Ack: 1, Len: 38
Source Port: 32323
Destination Port: 8@ Show Packet Bytes... Ctrl+Shift+0
[Stream index: 8] Expert Information
[TCP Segment Len: 38]
Sequence Number: 1 (relative sequence number)
Sequence Number (raw): 10@
[Next Sequence Number: 39 (relative sequence number)]
Acknowledgment Number: 1 (relative ack number)
Acknowledgment number (raw): 8
9101 .... = Header Length: 20 bytes (5)
Flags: @x@18 (ACK)
Mindonw; 8192 hd
45 60 00 4c 00 01 00 90 40 06 66 a7 Ga 90 80 01 E--N
0010 ©a 00 0@ 02 7e 43 00 5o [FICEIEENE o0 00 0o 00 ~C-P ]
5@ 10 20 9@ @58 ca @0 @@ 50 55 54 20 2f 31 2@ 48 P PUT /1 H
54 54 5@ 2f 31 2e 31 @d @a 43 6f 6e 74 65 6e 74 TTP/1.1- -Content
2d 4c 65 6e 67 74 68 3a 20 34 @d @a @d @a -Length: 4
@ 7 Sequence Number (tcp.seq), 4 bytes Packets: 16 - Displayed: 16 (100.0%) Profile: Default




Statistic:

M odd-http.peap

File Edit View Go Capture Analyze
Am:® REB ] &=
Source 7I

200.121.1.131

Statistics

= o X
Telephony Wireless Tocls Help

Capture File Properties l.\
Resolved Addresses I +
Protocol Hierarchy iFr;'-' Tk a
Conversations 1454 [TCP segment of a reassesbled PDU] |
Endpoints : =
Packat Lengthi 454 [TCP segment ‘cf a 'Easscrljlzld POU] ] ; ] o

54 [TCP Window Update] [TCP ACKed unseen s.4 [ACK] Seg=1 Ack=11281 Win=53808 Len=3
1/O Graph t t

Service Response Time  »
54 [TCP segment of a reassembled PDU]

DHCP (BOOTP) Statistics =
OMNC-RPC Programs 54 [TCP segment of a reassembled PDU] —~
29W » 2 g
et 1454 [TCP segment of a reassembled PDI
ANCP
b :
Collectd . ad
Frame 1: 1454 bytes on wire (1163 DNS (11632 bits)
Ethernet II, Src: Vmware_cB:80:01 Flow Graph Incare_42:12:13 (00:0c:29:42:12:13)
Internet Protocol Version 4, Src: @.122
Transaission Control Protocel, Sri HART-#P ort: 80 (80), Seq: 1, Ack: 1, Len:
HPFEEDS
HTTP ’
HTTPZ
Sametime
TCP Stream Graphs 3
UDP Multicast Streams
Py Statistics »
IPvE Statistics ’
00 0c 29 42 12 56 c@ 00 01 . ~
5 a0 61 41 0@ d3 90 c8 79
20 7a 20 3a 00 50 a7 5c 4 48 e2 €2 .
£F £f 77 67 88 00 38 54 73 57 77 51 ..ng..0T
3 78 70 74 44 63 51 4f 2 6b £a3xptic QO/KULAR
7 59 67 53 32 41 34 47 59 35 RFGYES2A 46Y51V32 o
Packets: 3083 - Displayed: 3083 (100.0%) * Load tme: 0:0.100 || Profle: Defauit
Ml odd-huppcap - a X
File Edit View Go Capture Analyze Statistics | Telephony Wireless Tools Help
® ¥ | VolP Calls
ANSI v B3 -] Bxpression. +
e - E
» Time Source Destnaton GSM LA |

200.121.1.131

172.16.0.

1AX2 Stream Analysis segnent of a reassembled POU]

ISUP Messages
3 0.025738 200.121.1.131 = , |=egment of 2 resssembled Pou]
4 ©.025749 172.16.8.122 window Update] [TCP ACKed unseen 5.4 [ACK] Seq=l Ack=11201 Win=63000 Len:
MTP3 v
RTP v
©.162939 200.121 RTSP , |[segment of a reassembled Pou] —
9 @.128285 SCTP * |segment of a reassesbled PDU]
SMPP Operations =
11 0.154162 UCP Messages segment of a reassembled PDU]
13 ©.179906 segnent of a reassembled PDU]
SIP Flows o
Frame 1: 1454 bytes on wire (11632 bits), St s)
hernet II, Src: Vaware_c@:00:01 (0@:5€:5 WAP-WSP Packet Counter 2:13 (@0:0c:29:42:12:13)

ac
a8
7a
£
61
66

29
el
29
33 7
a7

12
20
ee
ee
7@
9 67 53 3

se 56 c
es
S¢

" S O
BRgue
5w
soy
o
5R49&

34

Internet Protocol Version 4, Src: 200.121.17T3T; BEtr 172.1670.
Transmission Control Protocol, Src Port: 10554 (18554), Dst Port: 80 (88), Seq: 1,

Ack: 1, Len: 1400

el
79
2
51

08
el 8
ee
74

Ea3xptDc QO/kulAR
RFGYES2A 4GYS1VI2

35 31

Packets: 3083 * Dispiayed: 3083 (100.0%) * Load tme: 0:0.100 || Profiie: Default




Wireless:

Ml cdd-nttp.pcap - =] X
File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
dm @ BB ] &= L= Bluetooth ATT Server Attributes
Bluetocth Devices
Mo, Time Source Destination Pr Bluetooth HCI Summary
[ 1 0.000000 200.121.1.131 172.16.8.122 T WLAN Traffic eassembled POU] |
3 2.025738 200.121.1.131 172.16.0.122 TCP 1454 [TCP segment of a reassembled POU]
4 0.825749 172.16.0.122 200.121.1.131 TCP 54 [TCP Window Update] [TCP ACKed unseen 5.4 [ACK] Seq=1 Ack=11201 Win=53000 Len=2
7 ©.102939 200.121.1.131 172.16.0.122 TCP 1454 [TCP segment of a reassembled PDU]
9 0.128285 200.121.1.131 172.16.6.122 TCP 1454 [TCP segment of a reassembled POU]
11 0.154162 200.121.1.131 172.16.0.122 TCP 1454 [TCP segment of a reassembled POU]
13 8.179906 200.121.1.131 172.16.8.122 TCP 1454 [TCP segment of a reassembled PDU]

Frame 1: 1454 bytes on wire (11632 bits), 1454 bytes captured (11632 bits)

Ethernet II, Src: Vmware_c9:00:01 (00:50:56:¢0:00:01), Dst: Vmware_42:12:13 (00:0c:29:42:12:13)
Internet Protocol Version 4, Src: 200.121.1.131, Dst: 172.16.0.122

Transmission Control Protocol, Src Port: 18554 (18554), Dst Port: 8@ (80), Seq: 1, Ack: 1, Len: 1480

8@ Bc 29 42 12 13 2@ S8 56 cB 00 €1 08 02 45 o8
@5 20 @1 41 00 90 6a 06 d3 90 cB 79 01 83 ac 10
©2 7a 29 3a 90 S50 a7 5c @4 43 e2 e2 ee bf 50 10
ff £f 77 67 00 00 30 54 73 57 77 51 74 45 79 4e
45 61 33 78 70 74 44 63 51 4f 2f 6b 75 31 41 52 3xptDc QO/kulAR

52 66 47 59 67 53 32 41 34 47 59 35 31 56 33 32 RFGYS2A 46Y51V32 v

[ Packets: 3053 * Displayed: 3083 (100.0%) * Load tme: 0:0.100 || Profil: Defaut

Tools:

M <mtp.peap - [m] X
File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
dm @ TRE ] es = | Q¢ Firewall ACL Rules
iy & disg T Credentials (= K3
Source Destnaton tarag b mm
8 1.873326 74.53.140.153 10.10.1.4 TCP = 1470 [ACK] Seq=182 Ack=10 Win=5848 Len=0
9 1.874123 74.53.148.153 10.10.1.4 SMTP : 258-xc99.websitewelcome.com Hello GP [122.162.143.1%
1@ 1.e76669 18.10.1.4 74.53.140.153 SMTP : AUTH LOGIN
11 1.419021 74.53.140.153 le.10.1.4 SHMTP 334 VXNlcmShbWUé -
12 1,419595 10.10.1.4 74,53,140.153 suTP User: Z3VycGFydGFwQHBhdHIpb3RzLmlu —|
13 1.761484 74.53.140.153 1e.1e.1.4 SMTP 334 UGFzc3dvomQ6
mlﬂ 1.762058 10.10.1.4 74.53.140.153 SMTP Pass: cHVuamFiQDEyMw==
15 2.121738 74.53.148.153 10.10.1.4 SMTP 235 Authentication succeeded
16 2.122354 18.10.1.4 74.53.140.153 SMTP MAIL FROM: <gurpartapfipatriots.in> ==
< - i - - ) >

» Frame 14: 72 bytes on wire (576 bits), 72 bytes captured (576 bits)
Ethernet II, Src: Cradlepo_3c:17:c2 (8@:e@:1c:3c:17:c2), Dst: Netgear_d9:81:60 (8@:1f:33:d9:81:68)
Internet Protocol Version 4, Src: 10.10.1.4, Dst: 74.53.140.153
Transmission Control Protocol, Src Port: 1478, Dst Port: 25, Seq: 52, Ack: 355, Len: 18

v Simple Mail Transfer Protocol

Password: cHVuamFiQDEytw== Ml Wireshark . Firewall ACL Rules - smitp... — [a] x
M Wireshark . Credentials - smtp.pcap = a X —_—— —— —
# Windows Firewall (netsh) rues for smip.pcap, packet 14,
= S - . 2 B
Packet No. Protocol Userame Additional Info m‘rwr. \p 1470 Wireshark DISABLE
14 SMTP VycGFydGF h Il Username in packet 12
# Destination port,
| add portopening top 25 Wireshark DISABLE
| # 1Pv4 source address and port.
add portopening tep 1470 Wireshark DISABLE 10.10.1.4
| # IPv4 destination address and port.
L add portopening tcp 25 Wireshark DISABLE 74,53, 140, 153
_ Create rules for |Windows Frewall (netsh) d [ Deny
8c 99 05 be 00 19 7e c4 53 e4 ae ec 63 12 50 18 v 5soegP
Save o
fe 9d 54 bl @@ @0 63 48 56 75 61 6d 46 69 51 44 T --cH VuamFiQD L I
45 79 4d 77 3d 3d @d @a EyMw==

© 7 Password (smip.auth.password), 16 bytes Packets: 60 * Displayed: 60 (100.0%) Profile: smip_default




Help:

M cdd-http.pcap

File Edit View Go Capture Analyze Statistics Telephony Wireless Tools | Help

Adm 7@ RE Q&= iFEaaeqn Contents Fll
M Aoty 2 dislay fites Manual pages 3
= = F
No. Time Source Destination Protocol  Length I Website

200.121.1.131 172.16.0.122 1454 |

FAQ's
.825738 200. .131 72. 14 Ask (Q&A)
825749 416, Downloads

Wiki
.1082939 5 : 172.16.0.122 Smple Captures

.128285 .121.1.131 Check for Updates.

.154162 ,121.1.131 About Wireshark

Frame 1: 1454 bytes on wire (11632 bits), 1454 bytes captured (11632 bits)

Ethernet II, Src: Vmware_c0:00:@1 (90:58:56:c0:00:01), Dst: Vmware_42:12:13 (99:00:29:42:12:13)
Internet Protocol Version 4, Src: 200.121.1.131, Dst: 172.16.9.122

Transmission Control Protocol, Src Port: 18554 (10554), Dst Port: 88 (80), Seq: 1, Ack: 1, Len: 1400

89 ©c 29 42 12 13 @0 58 56 O 00 ©1 08 @0 45 g0

€5 a2 @1 41 9@ 9@ 6a @ d3 98 c8 79 @1 83 ac 1@
] a7 5c @4 48 e2 e2 ee bf 50 18
# 30 54 73 57 77 51 74 45 79 4e
45 44 63 51 &f 2f 6b 75 31 41 52

52 66 47 59 67 53 32 41 34 47 59 35 31 56 33 32 RfGVES2A 4GYS1V32

Packets: 3083 - Displayed: 3083 (100.0%) * Load tme: 0:0.100 || Profie: Defautt

JOBSHEET 6

Jelaskan fungsi menu “Main Toolbar” di bawah ini:

Toolbar
Icon

4 (tart]

Toolbar Item Menu Item

Capture | —
Start
m Stop |

Capture | .

Stop

ol Restart l Capture [—
Restart

@ (Options... | Capture | —
Options...

\Open...

Save As... |

@

\'Clase ]

4 (Reload]

— | Reload

Toolbar
Icon

Toolbar Item

Go Back

Go Forward

[Go To First

Menu Item

Packet J

Go To Last
Packet

Packet J

— | Last

Packet

[Auto Scroll in

l View l — | Auto

Live Capture] Scroll in Live
Capture ]
[Colorize] I View IH

52
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